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1. GETTING STARTED
There is so much to learn about computers. No one (besides Bill
Gates perhaps!) can ever know it all. If you are just starting, it is
important to realize it is not necessary to remember everything in
this manual. This manual provides you with a reference, describing
step-by-step procedures with lots of illustrations, to remind you of
things between computer sessions.
It’s a good idea to begin by getting familiar with the names of the
various components that make up the computer system. This will
make it easier to understand not only this book, but also any other
information you read or hear about computers. We will review
some terminology in this first chapter, and then describe how to
start a program, and how to switch off when you have finished.
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THE COMPUTER SYSTEM
A computer system is made up of a number of components. Some of them are
assembled in a box called a “tower”, and the others are connected to this
tower.
CPU

This is the “brain” of the computer where most of the processing
of information is carried out. Its full name is the Central
Processing Unit. This is where the computing power resides,
which is why this unit is generally referred to as the computer.

Monitor

Provides a visual display of information. It is like a TV screen.

Keyboard Used to communicate with the computer using letters and figures.
Mouse

Used to communicate with the computer by pointing and clicking.

Tower

Monitor

Mouse

Keyboard

This chapter of the Connections manual includes some material from Computers for Seniors, a
manual prepared by CLSC René-Cassin as part of a project entitled Two Model Programs to Sensitize
Older Women to Ageism and Consequent Abuse.
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Hardware

The tangible pieces of equipment – things you can hold in your
hand, such as the monitor and keyboard.

Software

A set of electronic instructions for the computer to do what we
want it to do (also called a “program”). The game Solitaire is one
software, WORD is another. The software is loaded (stored) into
the computer from diskettes or CDs.

INFORMATION STORAGE
Hard Disk This is the principal storage device where software and other
information is stored. It is located in the tower, and is often
referred to as Drive C:.
Diskette

Another device, (often called a Floppy Disk), on
which you can store information. A diskette stores
much less information than the hard disk, but it
can be taken out of the computer and used to
transport the information to another computer. A
unit in the tower, called the “floppy drive” or
“Drive A:”, is used to read and write on the diskette.

Compact Disk
Another storage device. Most software is currently sold on
compact disks. A unit in the tower called a CD-Rom or Drive
D:, reads information from compact disks. Although equipment
is becoming available to write to compact disks, most CD-Roms
are “read only” devices. This means you cannot store your own
information on CD, only on Drives A: or C:. (The CD-Rom is
like a stereo CD player, so you can play your favorite CD while
you work!)
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STARTING A PROGRAM
1. SWITCH ON THE COMPUTER
There are 2 switches to put on, one on the CPU and one on the monitor.
Wait a few minutes and a picture of the “Desktop” will be established. The
small pictures on the screen are called “Icons”. There is one for each
program.

The Start-Up Screen – THE DESKTOP

2. SELECT A PROGRAM

Using the mouse: ! POINT to the icon and CLICK.
The program will open in a rectangular box called a “Window”.
Note: On many computers you will find that a “double click” (clicking twice
quickly) is required to open a program.
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USING THE MOUSE
The mouse is used to give a computer commands without having to know hardto-learn key combinations. We use it to select programs, choose options and
size windows (see next page).
POINTING
The mouse sits on a rectangular “mouse pad”, similar in shape to the
computer screen. As you move the mouse on the pad you will
notice a “mouse pointer” (an arrow) moving on the screen. You
move the mouse towards the left on the pad, the pointer moves to
the left on the screen, and so on.

HOLDING THE MOUSE
The picture on the right shows how to hold
the mouse. This way the thumb and the
rightmost two fingers can guide the mouse
and hold it down firmly on the mouse pad,
while the remaining two fingers are ready
and available to press the mouse buttons.
THE FINE ART OF CLICKING!!!
Clicking on the left mouse button is the way we select something, such as a
program, or a document. It seems difficult at first but you will soon get the
hang of it if you do the following:
• Make sure the point of the pointer is right on the item you selected.
• Make sure the mouse itself does not move on the mouse pad as you
click.
• Keep the mouse firmly grounded on the mouse pad.
• Use a very light touch. Pressing harder does not help!

Esc

Made a Mistake? At first, like everyone else, you will often
click and get an unexpected result. No need to panic! Just hit
the Escape key at the top left-hand corner of the keyboard. It’ll
take you back to where you were.
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SIZING WINDOWS
The “window” containing the program you opened can be as big as your screen, or
you may still be able to see the desktop around it. The buttons at the top right hand
corner of the screen are for controlling the size of the window. For example, to
make the window you are working in fill the screen you can use the mouse pointer
to click on the “fill screen” button.
These buttons are
at the top right hand corner
of every window.

SHRINK FILL CLOSE
SCREEN

SWITCHING OFF
WARNING : NEVER SWITCH OFF WITHOUT
FOLLOWING THESE PROCEDURES.
The computer needs to tidy up and put all the files away
properly, or you may create problems for the next person
who uses the computer. There are 2 steps:

STEP 1: Close any program(s) you are using:
Before you switch off the computer, you must make sure that all the programs have
been closed. To do this, point and click with the mouse on the button marked
“X” at the top right hand corner of each open window.

Continued/……
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SWITCHING OFF (continued)
STEP 2 : Exit from WINDOWS:

Seems odd, but to finish you have to press ‘Start’!
1. CLICK on the Start button at the bottom left hand corner of the screen. The
Start menu will appear.
2. CLICK on the words Shut Down at the bottom of the list. A new window will
appear:
3. CLICK the OK button.
4. WAIT until you see the screen
display the following message
‘It’s now safe to turn off your
computer’
5. SWITCH OFF the computer with the same two switches you used to switch
on.

THAT’S IT!!!
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2. WRITING TEXT

In this chapter we describe how you can enter text into the computer.
When you begin using the computer, it is a good idea to first practice
by writing something using the word-processing program called
WORD. The keyboard skills you will learn are also the ones you will
use in other programs, and for e-mail and the Internet. If you are
looking for ideas for what to write about, you may get ideas from the
exercises provided in an appendix at the end of this manual.
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ENTERING TEXT
What you see on the screen when you start WORD is an empty page, ready for
your work. It is surrounded with tools you will learn to use later, but for now we
will focus on how to write on the empty page using the keyboard.
The WORD Screen

The Cursor
The blinking line you see on the empty page is called the cursor (also known as the
insertion point). It is placed ready for you to start typing at the top left corner of
the page. When you type, the text always appears to the left of the cursor so it
moves along as you type.
Typing
Type with the alphabet keys like you would on a typewriter. However, when
you get to the end of a line the computer takes care of keeping the text inside the
margins. When one line is filled, the next text you type “wraps around”: in
other words it is automatically placed on the next line. You don’t have to press a
“return” key at the end of each line like you do on a typewriter.
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SPECIAL KEYS
Making spaces:
↵ Enter

This key tells the computer you want to start a new line. Use it when
you want to start a new paragraph or begin the next sentence on a new
line. It creates a new line and moves the cursor to the next line.
You also use this key to make empty lines at the beginning of your
document or between paragraphs. Each time you press ↵ Enter a new
line space is created.

Space Bar

Adds a letter space. Use this to put spaces between your words. It is
the long key at the front of the keyboard.

Using Capitals
" Shift

If you want to make a Capital letter, hold down the " Shift key at the
same time as you press the letter key. For example, do this to capitalize
the first letter of the word at the beginning of a sentence.
Also, use the " Shift key to type the symbols printed on the top part of
some of the keys, e.g. the $ sign above the number 4.

Caps Lock

Sometimes you may want to capitalize several words, such as when you
write a title in capitals. In that case you can use the Caps Lock key.
Press it and release it once; after that everything you type will be in
caps. (Notice a green light on the top right hand side of the keyboard
indicates that the caps lock key is on.) When you no longer want the
text in caps, press the Caps Lock key again to switch it off.

Making corrections
To make a correction, first move the cursor to the place you want to add
or delete letters (see next page).

←Backspace

Deletes the letter or space that precedes the cursor.

Delete

Deletes the letter or space that follows the cursor.

Check the position of these keys on the keyboard layout diagram.
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MOVING AROUND THE PAGE
You can change what you have entered without retyping it all. To do so you first
have to tell the computer where you want the changes to appear by moving the
cursor to the appropriate place.
There are 2 ways of moving the cursor:
1. Using the mouse: !
POINT to the location where you want to make the change. (When you
point in your document the mouse pointer is a thin line symbol rather than
an arrow). CLICK with the left mouse button and the cursor will appear and
start blinking in its new location.

#

2. Using the keyboard:
There are arrows keys and other keys on the keyboard that move the cursor
to the place where you want to make changes. They are indicated on the
Keyboard layout sheet.
↑
←

↓

→

Look for these keys to help you move around faster:
Home

Takes you back to the beginning of the line

End

Takes you to the end of the line

Page
Up

Moves up one whole screen of text

Page
Down

Moves down one whole screen of text

Before you go on:
There is a lot more to know about editing but if you have mastered the concepts on
these last few pages you are on your way. The keyboard layout diagram will help
you review the most important keystrokes.
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A
Z

S
X

E

3
D

F

H
N

U

7
J
M

I

8

Space Bar

B

Y

6
G
V

T

5

Shift - To make a single capital letter
Shift - To make a single capital letter
hold this key down while pressing the
hold this key down while pressing the
letter.
letter.
Caps Lock - Press this to make all
Caps Lock - Press this to make all
subsequent letters capital. (Press it
subsequent letters capital. (Press it
again to revert to lower case letters.)
again to revert to lower case letters.)
You also use this key to get the
You also use this key to get the
symbols that are at the top of the keys
symbols that are at the top of the keys
when they have two symbols, e.g. the $
when they have two symbols, e.g. the $
sign above the number 4.
sign above the number 4.

C

R

4

$

CapitalLetters
Letters
Capital

Shift

Caps
Lock

W

Tab Q

@

2

!

1

Esc

,

L
.

P

0
‘

Enter

Delete - erases the
next letter
next letter

Use this key to begin
Use this key to begin
again on a new line or to
again on a new line or to
create a new empty line.
create a new empty line.

Use these keys to move the cursor
Use these keys to move the cursor
to where you want to type next. The
to where you want to type next. The
arrows move the cursor in the
arrows move the cursor in the
direction they are pointing.
direction they are pointing.
Home - moves the cursor to the
Home - moves the cursor to the
beginning of the line
beginning of the line
End - moves the cursor to the end
End - moves the cursor to the end
of the line
of the line

CursorControl
ControlKeys
Keys
Cursor

Delete End

Home

Backspace - erases the
previous letter
previous letter

Keysthat
thatErase
Erase
Keys
Backspace - erases the
Delete - erases the

TheEnter
EnterKey
Key
The

K

O

9

For example, it gets rid of windows or menus that are
opened by mistake.
opened by mistake.

Escape! This
This key reverses an unexpected result.
Escape!
key reverses an unexpected result.
For example, it gets rid of windows or menus that are

KEYBOARD LAYOUT
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A

Z

S
X

D
C

R

B

H
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U

7
J
M

I
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Space Bar

V

G

Y

6

You will find the keys you need in the area circled
You will find the keys you need in the area circled
above.
above.
For â, î, ô, ç, à, è, Â, Î, Ô, Ç, À, È :
For â, î, ô, ç, à, è, Â, Î, Ô, Ç, À, È :
press and release the key for the accent, then
press and release the key for the accent, then
press the letter, using the Shift key with the letter
press the letter, using the Shift key with the letter
if you want a capital letter.
if you want a capital letter.
For é you only need one keystroke, and the
For é you only need one keystroke, and the
same key with the Shift key for É.
same key with the Shift key for É.

F

T

4 5

$

Accentedcharacters
characters
Accented

Shift

Caps
Lock

3

W E

“ @
1
2

!

Tab Q

Esc

K
,

O

9

.

;

`
Alt

é

^

¸
Enter

>
<

Delete End

Home

Experiment to find out what other characters you can get using the
Experiment to find out what other characters you can get using the
number keys with the right Alt key or the Shift key.
number keys with the right Alt key or the Shift key.

To accommodate the accents, some symbols have moved
To accommodate the accents, some symbols have moved
For the apostrophe, (as in l’enfant) use the Shift key with the comma
For the apostrophe, (as in l’enfant) use the Shift key with the comma
key.
key.
The French quotation marks, <>, are on the key above the Enter key.
The French quotation marks, <>, are on the key above the Enter key.
To get @, the character used in E-mail addresses, press and hold down
To get @, the character used in E-mail addresses, press and hold down
the Alt key on the right side of the Space Bar followed by 2.
the Alt key on the right side of the Space Bar followed by 2.

Locatingother
othersymbols
symbols
Locating

L

P

0

By changing the keyboard setting from English to French, you can write in French in WORD, E-mail
and other programs. After opening your software, look for the blue keyboard icon “En” at the bottom
right hand corner of the screen, click on it and select French(Canadian), to change it to “Fr”.

WRITING IN FRENCH

3. WORD BASICS
The WORD program is for preparing documents. You can use it to
write a simple letter or to prepare a longer document. It has many
features that make it possible to prepare complex documents with
illustrations, columns, page numbers and all the bells and whistles, but
most people never need most of what it can do. In this chapter we
cover some of the basic features you will use to prepare and print out
a simple document.
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MENUS AND TOOLBARS
When you write a document in WORD, the top of the screen shows a lot of useful
information and tools.
Title Bar

This is the top border. It shows the name of the document you are
working on.

Toolbars
Menu Bar
Below the Title Bar is a row of words.
These are called “MENUS” because each
offers a pull-down list of choices when you
click on it. For example, in most programs
the first menu on the left is File.
The diagram on the right shows what happens
when you click on the word File. A pull-down
menu appears. You then move the mouse
pointer down to the item you want, and choose
it by clicking. For example, you could click
on the word Exit to close WORD.

Toolbars
Below the Menu Bar are rows of pictures. Each row is called a “Tool Bar”
because each picture offers a different tool to help you create your document. The
toolbars shown may not always be the same, but the picture above shows the two
most often used. You will learn about them in the next section and in the chapter
on editing.
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THE STANDARD TOOLBAR

These icons or “buttons” are quick ways of doing the things you need most. Just
point and click once on the one you need.
OPENING AND SAVING DOCUMENTS

NEW OPEN SAVE
NEW

Opens a new document when you want to start something completely
new.

OPEN

Use when you want to open a document you previously saved. It will
bring up the “Open” dialogue box to help you select your document.
For more information about how to use this dialogue box, see the
instructions called “Retrieving (Opening) a document”, on page 20.

SAVE

This saves your document. Use it when you have already given your
document a name, and you want to save it to the same drive you saved
on before.
NOTE: If the document is new you will need to give it a name and
you should use the File Menu (Click on File, Save As), as described
on page 18.

HELP!

This button is known as the HELP. The idea is to
click it when you cannot figure out what to do. You
can search for the answer to questions about WORD.
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“UN-DOING” YOUR MISTAKES

UNDO

REDO

UNDO

This is the life-saver!! Use this when something just happened you
did not anticipate, or when you change your mind about the very last
thing you did. It will restore your work to the way it was before.

REDO

You will only need this if you change your mind about undoing
something, or if you clicked on the undo button by mistake. It
reverses the previous “undo” command you made.
FINAL CHECK AND PRINTING

PRINT
SPELL
CHECK

VIEW SPELL

You may want to check for spelling mistakes before you print.
This button will go through your text and show you words that are not
spelled as they are in the WORD dictionary. You can ignore or
change the words as you wish.

PRINT
Click on this button to see how the text falls on the whole page.
PREVIEW You can then make adjustments before printing.
PRINT

This prints your document, but check first that the printer is on and
loaded with paper. (There may also be a printer switch to check if
more than one computer is connected to the same printer).
Note: If you only need to print one or two pages of a long document
you should use the File menu instead. (Click on File, Print)
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SAVING YOUR DOCUMENT FOR THE FIRST TIME

If you are going to save your file on a
diskette, first put it in the computer.

1. CLICK on the word File, to get the File menu.

2. CLICK on the words Save As. You will now see a
window called ‘Save As’. It shows a list of the files in
the hard drive C:

continued/.…

DRIVE C: The filing Cabinet
There are so many files in the hard drive (C:)
that they need to be arranged in folders. You
can think of the hard drive as a filing cabinet,
with all the files arranged in folders. In the
‘Save As’ window you see a list of the files in
only one folder. If you are curious, ask
someone to show you how to look in the other
folders.
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SAVING YOUR DOCUMENT FOR THE FIRST TIME (continued)

3.

Decide where you will save your file:
To Save on the Hard Drive (C: ) Go to step 4.
OR
To Save on a diskette (A: )
CLICK on the small arrow beside the box
marked ‘Save in’.
A pull-down list will appear.
CLICK on ‘3½ Floppy (A:)’
The ‘Save As’ window will now show the list of
files on your diskette.

4. CLICK inside the Box called ‘File name’.
This puts the cursor in the box.
TYPE in the name you have chosen.
5. CLICK on the Save button at the right of the screen.
You will see a message at the bottom of the screen as the computer saves your
document. You will now be able to retrieve it again at any time.
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RETRIEVING (OPENING) YOUR DOCUMENT
1. CLICK on the “Open” button on the Standard Toolbar(see page 16). You

will now see a window called ‘Open’
Now you can tell the computer where to find your document.

2. In the window you see the list of files in the current folder of hard drive C:.
If your file is on this list on hard Drive C:, GO TO STEP 3.
OR
If your file is on a diskette (Drive A:)
First make sure your diskette is in drive A,
then CLICK on the small arrow beside the
box marked ‘Look in’. A pull-down list will
appear.
CLICK on “3½ Floppy (A:).
The ‘Open’ window will now show a list of the
files on your diskette (A:).
3. Find your document in the list shown in the window, then POINT to it and
CLICK . The name will become highlighted in blue.
4. CLICK on the Open button at the right of the screen.
After a moment, your document will appear on the screen.
Congratulations!!! You are now ready to work on your document.
20

4. EDITING YOUR WORD DOCUMENT

The wonderful thing about writing on a computer, compared to using
a typewriter, is that it’s so easy to make changes. No need to start
over or to get out the liquid paper! You can even give your document
a whole new look without re-typing a single word. This chapter
describes some quick ways to update and enhance your documents.
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SELECTING TEXT
You will probably want to make changes to your document, such as deleting a
sentence, moving a paragraph, or putting part of the text in italics. To do these
things you need to tell the computer which part of the text you would like to
change, in other words “Select” the text. When you “select” text it’s appearance
changes: the letters become white highlighted in black.

To select words, sentences or part of a text:
1. POINT with the mouse to the beginning of the first word of the text you want
to select, and CLICK to place the cursor there.
2. PRESS DOWN the ↑Shift key with your left hand, and keep holding it
down.
3.
Still holding the ↑Shift key down, POINT to the end of the text you want
to select and CLICK. (If the text runs off the screen use the Page Down key). You
will see the text has become highlighted in black. Now release the ↑Shift key.
TIP: Any time you select text in error and want to get rid of the highlight, just
click the mouse anywhere in the text frame where there is no highlight.

More tricks:
1. If you move the pointer to the margin at the left of your text you will see it
looks like an arrow $. When you have put the pointer in this position:
Clicking once will highlight one line
2. To select the whole document, click on the Edit menu, then use Select
All.

Alternative way to select (dragging):
You will soon find out that dragging the mouse across some text will highlight it.
If you have a steady hand this is very useful. However it often happens by mistake
and you find some of your text goes black when you didn’t intend to highlight it.
Just click somewhere on the white part of the page to remove the black highlight.
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MOVING THINGS AROUND

CUT COPY PASTE
MOVING TEXT
If you want to take some text and move it to another place in your document:
1.

SELECT the text you want to move.

2.

Click the CUT button on the standard toolbar. Don’t worry, the text has been
deleted from the screen, but it is not lost.

The computer has a special area of the hard disk called the CLIPBOARD. When
you use the CUT or COPY buttons this is where the text is saved so that you can
use it again. You can even use it in other applications such as E-mail.
3.

CLICK with the mouse at the position in your document where you want the
text to be placed. The cursor is now at the chosen spot.

4.

Click on the PASTE button. You will see the text re-appear in the place you
chose.
COPYING TEXT

If you want to repeat some text, copying it to another place without deleting it in
the original location:
1.

SELECT the text you want to move.

2.

Click the COPY button on the Standard toolbar. This action copies the
selected text onto the clipboard.

3.

CLICK with the mouse at the position in your document where you want the
text to be copied. The cursor is now at the chosen spot.

4.

Click on the PASTE button. You will see the text appear in the place you
chose.
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THE FORMATTING TOOLBAR

This second toolbar is to help you format your document. It has several useful
buttons.
ALIGNING YOUR TEXT

LEFT CENTRE RIGHT
When you start a new document it will automatically be left aligned, all the text
starting flush on the left-hand-side of the page, just as it is in this paragraph. If you
look at the formatting toolbar you will see that the button for LEFT alignment
appears to be pushed in.
You may decide that part of your text should be right aligned, like this paragraph,
in which case you should click on the RIGHT alignment button before typing it.
Or you may want to centre a title like the one at the top of this page, and you can
do this by pressing the CENTRE alignment button.
BOLD, ITALIC AND UNDERLINE

BOLD ITALIC UNDERLINE
As you type you can change the look of certain words or sections by pressing the
button corresponding to the kind of letters you want.
BOLD

This text is bold.

ITALIC

This text is italic.

UNDERLINE
This text is underlined.
You can also have more than two of these buttons pressed at once. For example
this text is both italic and underlined.
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CHANGING THE SIZE AND STYLE OF THE LETTERS
The size of the letters in your text is measured in “points”. This text is 14 point.
This is 10 point. While you work, the point size you are using is displayed on the
formatting toolbar:

“Times New Roman” is the name of the font or typestyle used for this sentence,
and this can also be changed. This sentence is written in Arial. You may want
to be fancy and dress up your document, or you may want it to look more casual.
The best way to change the font is to use the Format menu, because then you will
see a preview of what the typeface looks like. To change the font:
1.
2.

CLICK with the mouse on the word Format. The format menu will drop
down.
CLICK on the first item: Font. The window shown below will appear.

3.

Preview the fonts and CLICK on your choice, then PRESS OK.

Note: The text alignment and text styles do not have to be set in advance as you
type. You can type the whole text first and then go back later to set the final
format. Just SELECT the words you want to change (proceeding as described on
page 22), then use the toolbar buttons or the Format menu as just described.
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EDITING FROM THE MENUS
OTHER EDITING FEATURES YOU CAN USE
Now that you’re an expert in selecting text and using the editing buttons on the
toolbars, you will want to try other options available from the menus. Try out the
ones that interest you most. To do so:
1. CLICK at the point in your document where you want to make the change, or
SELECT the part of the text whose appearance you are changing.
2. CLICK on the name of the MENU.
3. CLICK on the feature you need.
4. FOLLOW the choices given in subsequent windows or lists.
Here are a few examples of what you can do: (Note: This table excludes features
described in the preceding pages).
FUNCTION

MENU SELECTION

Change Margins

File

Page Set Up

Change Paper Size

File

Page Set Up

Add Page Numbers

Insert

Page numbers

Add the Date

Insert

Date

Start a new Page

Insert

Break

Add foreign characters
or math symbols

Insert

Symbol

Change Line Spacing

Format

Paragraph

Add Borders or Shading

Format

Borders

Write in columns

Format

Columns

Add a picture

Insert

Picture

Note: Setting Tabs is not covered in these instructions. They are not easy to
master, but if you would like to know how, ask someone to show you.
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5. USING THE INTERNET
In this section we will take you step-by-step through signing on to the
Internet and describe ways you can move to different sites on the Net
to access information. We will not attempt to explain how the
Internet works or define terminology. We believe you will gradually
get used to the terminology, acquiring a good sense of what it is all
about by using it.
For the Connections project the ‘browser’ we are using to get around
the Internet is called Internet Explorer. Some of the instructions are
specific to Explorer, but in general the process and tools are very
similar when you use other browsers such as Netscape.

www……
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GETTING ON THE INTERNET
1. On the desktop, CLICK on the icon for INTERNET EXPLORER (the one
with the large blue “

e ” symbol).

A connections window will
appear. You will see a box for
your site’s “User name” and
another for the “Password”.
They must be completed so
your Internet Service Provider
(ISP) knows you are a
legitimate user. The “User
name” is usually already
entered (in the picture on the
right it is “Connect”).

2. TYPE IN THE PASSWORD.
Important tips:
1. This is the group password for your location, the same one for all the
participants at your site. This is not your personal E-mail password.
2. Type carefully because the password is secret and appears on the screen as
asterisks. You will not be able to see if you have made a mistake.
3. When you type in the password it is case sensitive: include capitals only if
they were capitals in the password originally selected.
3. PRESS ↵ Enter OR CLICK on the Connect button.
You will hear a high-pitched ringing sound as the computer dials in to your
Internet Service Provider (ISP). A new window appears telling you dialing is
in progress, then gradually you will see information from the first Web-site
building up on the screen. This is your ‘Home Page’.
4. WAIT until the Home Page is complete.

Welcome to the
Information Highway!!!
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FINDING INFORMATION
From your home page you can reach web sites anywhere around the world. Each
one has its own address. The addresses work just like telephone numbers, allowing
you to go to the exact computer site to retrieve the information. You will
recognize Web site addresses by the www. or http:// that they start with.

There are several ways of finding the information you want:
ENTERING A KNOWN ADDRESS
Type the exact web-site name in the box marked Address: and press ↵ Enter
SEARCHING
CLICK on Search , or type in the web address of one of the indexes listed
on page 32 and press ↵ Enter. These index sites have directories and ‘search
engines’ that will help you find what you want.
When the index site is on the screen you can use one of 2 methods to search:
EITHER choose one of the topic categories they list according to your interest
OR enter a keyword(s) in the box provided for Searching the Web.
You may not be exactly sure what you are looking for! Don’t be afraid to try a
number of different categories and keywords. You may be amazed at where it
will lead you.
This is what’s known as surfing the web.
Each time you make a choice you will be sent a list of categories or sites to
choose from. Continue choosing until you narrow the search to a site that
interests you. If you don’t like the way the search is heading, click on Back to
go back to the previous Web page or Home to go back to the Home Page.
USING “FAVORITES”
Web sites that are visited frequently from your own computer can be saved on a
list of ‘Favorites’ (also known as ‘bookmarks’). To access them, click on the
word Favorites on the Menu Bar. The list of favorite sites will drop down.
Click on your chosen site to open it.
BE PATIENT! It may take several seconds or even minutes for a Web page to build up on
the screen, depending on how busy the Internet is. As the information comes in you will see the
globe turning in the top right hand corner of the screen. Wait until the globe stops turning before
you give any more instructions with the mouse or keyboard, otherwise you may interfere with
the flow of information.
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LINKS
Most browsers and web pages have buttons, graphics or headings that will lead
you to other pages or other sites on the Internet. These are called ‘links’. The
text associated with the links is usually highlighted in color or underlined. You
will know that it’s a link if a small hand appears when you point to it with the
mouse pointer. Just click on the link to get to another page of information on
the topic.

GETTING AROUND A WEB PAGE
The information on a Web page will usually run off the screen, so you can only see
a part of it at any one time. Use the cursor control keys or click on the ‘scroll
bars’ to move around the document. The scroll bars are along the right hand edge
and the bottom edge of the page. The one at the right is used to scroll the text up
and down while the one at the bottom moves it to the left or right.

Scroll Arrow →
Scroll Box→
→

SCROLL BARS
Click on the arrows to scroll one
line at a time.
OR
Click and drag the scroll box to
move faster through the document
Scroll Bar

LEAVING THE INTERNET
1. Close Microsoft Explorer:
CLICK on the X button at the top right hand corner of the screen.
2. Disconnect from the Internet: CLICK on the Disconnect button in the
connection window. (If this window does not appear automatically, click on the
ISP icon on the desktop – the symbol is a telephone connected to computers.)
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WEB SEARCH TOOLS
You will find several of the menu options and buttons on the tool bar helpful.
BACK

Click this button to go back to the previous Web page you were
looking at.

HOME

Click this button to return to the Home page.

HISTORY

Click here to get a list of all the sites visited recently. This is
helpful if you want to return to a site you saw earlier, or even a
few days before, but can’t remember the address. Just click on
the one you want to return to.

FAVORITES

Use this menu when you know you have found a good site you
know you will want to return to. Select “Add to Favorites”.

PRINT

Click the PRINT button to print the Internet page you are
viewing.
Be wary!
There may be many pages of
information on this topic and you might really only need a
small part of it. Pressing the Print button will print all the
pages, so it is often better to use the File Print command, since
it will bring up a window which provides an opportunity to
print selected pages. However you may still not know what
page numbers you want. A better alternative in this case is to
save the information to a file and print it from WORD.

SAVE

The procedure for saving information from a Web site is the
same as saving a document in WORD. Use the File menu and
select Save As. Select the folder where you want to save the
information and give it a name. You can choose to save it as an
HTML file or as a rich text file. WORD will read either file.
The HTML version will be complete in WORD, including all
the colours and graphics, but will take up a lot of memory and
may be difficult to edit. The rich text version will give you
only the text, but will be available for you to reformat.

SEARCH

This opens a side bar with Explorer’s access to search engines.
It is an alternative to using the web search offered on your
Home Page.
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TRY THESE WEB SITES
Two things to note:
1. You do not usually need to enter the prefix http://.
2. There are never any spaces between the words in the address.

Indexes
infoseek.com
yahoo.ca
www.askjeeves.com
Seniorssearch.com
pic5.infospace.com/canada/
people.htm

A good point to start a search.
A good point to start a search.
Use a complete sentence to find information.
A good point to start a search.
A place to search for someone you’ve lost touch with:
includes Canadian and international indexes.

Other starting points with good links
www.ageofreason.com A resource centre with links to many sites of interest
www.seniorcentre.ca Information, discussion and courses for seniors interested
in learning.
www.mbnet.mb.ca Seniors site, with links to many topics of interest
including genealogy, humor, computers, libraries…
The
CARP (Canadian Assoc. of Retired Persons) site.
www.fifty-plus.net
Information, joke of the day, forums, and more.
riaq.uqam.ca A bilingual site for Quebec seniors

News Sites
www.canoe.com
(recommended home page)
www.globeandmail.ca
www.cnn.com
www.telegraph.co.uk
www.jpost.com

Canadian news, health information, weather, sports,
crossword and more.
Web version of the Globe and Mail.
CNN news from the United States
Internet version of the Telegraph from the U.K.
Internet version of the Jerusalem Post

Other Sites of Interest
www.mcgill.ca McGill university’s web-site: research information, links
to all the departments and faculties, directories.
www.montrealonline.ca Montreal: events, galleries, museums, restaurants ….
www.cbc.ca CBC’s web-site, with schedules, program information and
live radio.
www.iga.net/qc Order your groceries for home delivery!
www.landsend.com Fashion store: view and order clothing.
www2.bluemountain.com Send an animated greeting card over the Web.
www.humormatters.com A place to go to put a smile in your day.
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6. ELECTRONIC MAIL
There are a number of different E-mail programs we could use. One
is Microsoft Outlook which comes with Internet Explorer, but for this
project we will be using a free on-line service called Hotmail.
Hotmail has the advantage that each user can have their own E-mail
address and private mailbox.
In addition all the messages are
maintained at the Hotmail server, not at the local computer, and a user
can therefore read and send mail from any computer that has access to
the Internet.
Each user registers with Hotmail and choses an address and password.
The address is in the format myname@hotmail.com. All E-mail
addresses have this format: the part before the @ sign is specific to
each user, while the part after the @ sign is the name of the service
provider. Your E-mail address can be given to anyone who would
like to send you messages, while your password is something known
only to yourself and anyone else you can trust to help you access your
mailbox.
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ACCESSING YOUR MAIL
1. CLICK on the INTERNET EXPLORER
icon on the desktop. The “connection
window” appears.
2. TYPE in the PASSWORD for your ISP
provider. (Note this is described in more
detail in the previous chapter). Then PRESS
↵ Enter or CLICK on the Connect button.

No connection window?
If the connection window
does not appear at step 1,
pass to step 3 and it will
appear after you select
Hotmail, in which case you
can enter the password at
that point instead of earlier.

3. WAIT until the Home Page is complete.
When the page is complete the globe at the top right hand corner of the screen
will stop turning.
4. CLICK on the FAVORITES menu and SELECT HOTMAIL.
(An alternative would be to enter the web address www.hotmail.com).
The Hotmail Home Page will appear with a sign up screen.
5. ENTER your personal Hotmail USERNAME and PASSWORD in the
boxes provided. Then PRESS ↵ Enter.
A new page appears showing the contents of your own personal mail in-box.
You are now ready to read your mail or compose your own message.

LEAVING HOTMAIL AND THE INTERNET
1. Leave Hotmail:
CLICK on Sign Out.
This takes you out of Hotmail, but you can still go to other web sites since you
are still connected to the Internet.
2. Close Microsoft Explorer:
CLICK on the X button at the top right hand corner of the screen.
3. Disconnect from the Internet: CLICK on the Disconnect button in the
connection window. (If this window does not appear automatically, click on the
ISP icon on the desktop – the symbol is a telephone connected to computers.)
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READING YOUR MAIL
The messages in your In-Box are the first thing you see when you sign on. They
are listed with the sender’s name or e-mail address, date and subject. New
messages are indicated by an arrow at the left. You are told how many messages
are in the in-box and how many are new. You may need to use the cursor keys or
the scroll bar to view the entire list of messages.

To read a message, CLICK on the sender’s name in the “From” column.
The message will be displayed. Use the scroll bar to reveal the entire message.
After reading your message you can choose from the options shown both above
(and repeated below) the message:

If you choose REPLY, a new message box appears with the name of your
correspondent already entered. How to prepare and send your message is
described on the next page.
The options are all self evident, but if you are unsure what any one means, give it a
click and try it out. You can also print the message by clicking on the File menu
and selecting Print.
To record the person’s address, put it in your address book. This is done while
the message is open, by simply clicking on the link Save Address, which is
alongside the sender’s E-mail address at the top of the message.
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COMPOSING A MESSAGE
Start by selecting the compose option that appears above your in-box. A new
display appears ready for you to write your message:

1. ENTER the E-mail address of the person you are writing to. If you used your
address book (see next page) or if you are replying to an E-mail, the address
will already be there.
2. CLICK in the box marked ‘Subject’ and GIVE your message a title.
3. CLICK in the box provided for your message. At first you only see the top
part of the box. Using the scroll bar reveals the rest of the page.
TYPE your message.
4. When you are satisfied with your message CLICK on Send .
Your message is immediately on its way through Cyberspace!!!
Editing your message Clicking on the right mouse key while your cursor is in
the message area will bring up a menu with features for cutting, copying and
pasting which work the same as the equivalent buttons on the WORD toolbar.
Preparing your message in WORD To save time spent on the Internet you
can write the message in WORD and COPY it onto the ‘Clipboard’. It will stay
on the clipboard as long as the computer is not switched off. Exit from WORD,
sign on to Hotmail, then when your cursor is in the message box ready to write
your message, CLICK on the right mouse key to get the edit menu, and
PASTE your text into the E-mail message.
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THE ADDRESS BOOK
Taking the trouble to put your friends’ and relatives’ addresses in your address
book is time well spent. Once they are there you will never have to enter them
again and you won’t have to worry about remembering them.
ADDING SOMEONE TO YOUR ADDRESS BOOK:
1. CLICK on the Addresses option that appears above your in-box. A new
window will show you your address book entries.
2. CLICK on Create New. A screen will appear for entering the information.
3. ENTER the Nickname and E-mail Address in the boxes provided. There is no
need to give all the other details they ask for. Then CLICK on OK.
TO USE THE ADDRESS BOOK:
When you compose a letter, select Addresses instead of Compose. Hotmail will
display the list of people in your address book. CLICK on the E-mail address of
the person you want to write to, and a new message screen will appear with the
address already in place.

ELECTRONIC MAILING LISTS
Sign up for an electronic mailing list to:
♦ Receive announcements of new initiatives, concerts, events, publications or
products.
♦ Share information about hobbies or interests
♦ Discuss politics and other current issues
♦ Share information about TV shows, movies, entertainers
♦ Exchange medical information
♦ Regularly receive a quote, story or joke
On discussion lists, messages from other subscribers will appear in your E-mail
box, and everyone on the list will receive your contribution. Select a mailing list at
the web site www.liszt.com or from the discussion groups offered by www.fiftyplus or www.thirdage.com. Signing on is easy, and you can give yourself a
nickname if you prefer to keep your identity private.
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OTHER E-MAIL FEATURES
The principal E-mail features are listed along the top of your personal Hotmail
screen. We have already discussed the first three, the In-box, Compose and
Addresses. If you use E-mail regularly you are going to find the others useful too.
Folders
This option lets you organize your correspondence by filing messages away in
folders. Clicking on the Folders option will show you the existing folders that
Hotmail has created for you. You can make others, naming them for specific
correspondents or topics. Once they are created you can tidy up, delete
messages you don’t want, and move others to appropriate folders. To do this,
select the messages by clicking the small boxes to their left, then:
To delete: CLICK on the Delete button above the list of messages.
To file the message: SELECT the folder from the pull-down list called
“Move to Folder”.

Options
This enables you to personalize settings. For example, you can automate your
signature, change default options for your replies and change your options
regarding directory listings.
Help
Clicking here is the best way to find answers to questions not covered in this
chapter. This User’s Guide has easy to follow instructions on a lot of
Hotmail’s features. It includes Instructions on how to change or be reminded
of your password.
NOTE: The pictures and some of the details in these instructions are all taken from
Hotmail, but all E-mail packages have similar features. If you can use one, you
will quickly be able to adapt to another package.
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APPENDIX:
WRITING AND EDITING EXERCISES

The exercises presented here are intended for practicing writing and
editing with the keyboard. They also offer ideas of what people might
like to write about. They are not intended to be done in any particular
order, rather they offer a choice and can be used according to people’s
needs and interests.
Each exercise is stored on the hard disk in a folder called “Exercises”
and can be opened for editing. When you have completed the
exercise, you can save your work on your own diskette.
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EXERCISE 1
Edit this so it describes your own home town.

MY HOME TOWN
Vancouver is a wonderful city. It has a beautiful setting with a backdrop of the
Rocky Mountains. From one of the city’s many harbours ships can sail out to the
Pacific Ocean.
The biggest park, located in the heart of the city, is Stanley Park. Vancouver
citizens love to cycle, jog, roller blade or walk in the park.
You can get around town very quickly by public transportation. Everyone loves
the SkyTrain which moves on an overhead rail.
The Vancouver climate is very mild. We get very little snow in the winter and by
March there are already daffodils and crocuses blooming everywhere. People who
like to ski go up to Whistler which is not too far away.
I am very proud of Vancouver’s basketball team, the Vancouver Grizzlies. They
have been having a very good season this year.

******************************************************************
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EXERCISE 2
You have two options here: you can edit it so that it describes this year and why it
is special, or you can add some paragraphs about why 1967 was special for you.
THIS YEAR – 1967
This year is special because we are celebrating Canada’s one hundredth birthday.
It is 100 years since Confederation.
Pierre Elliot Trudeau is Prime Minister of Canada and Jean Lesage is Premier of
Quebec.
In the summer many thousands of visitors will be coming to Montreal. They will
visit Expo 67.
Many sports fans will be going to the hockey games at the Forum. In the summer
they go to see the baseball at Jarry Park.
Place Ville Marie is the tallest building in Montreal.
International flights are now coming in at Mirabel airport
The Beatles are at the top of the hit parade.

**********************************************************
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EXERCISE 3
Edit this so it describes yourself. When you get to the last paragraph you can go
on to tell more about your work experience.
ON BEING BILINGUAL
My name is Jean Smith.
I did not always live in Montreal. I was born in Ottawa, Ontario, but now I have
lived in Montreal for 25 years.
In Montreal it is good to be bilingual. My mother tongue is French. I spoke
French with my family at home. I learned English at school.
During the years I worked as a chef I always used French. I only used English
when ........

*****************************************************************
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EXERCISE 4
Here are some quotes that are good to copy type. Choose the one(s) you like best
and type them in a new file. You could “dress up” the page by using fancy fonts.
Another exercise could be to open the existing file, and re-order the list using the
“Cut, Copy, Paste” buttons on the toolbar.

FOOD FOR THOUGHT
Nobody trips over mountains. It is the small pebble that causes you to stumble.
Pass all the pebbles in your path and you will find you have crossed the mountain.
-UnknownSome people change their ways when they see the light; others when they feel the
heat.
- Caroline SchoederLove is like the sun: when it's there, you just want to wallow in its glow, and when
it's gone, you just want to sleep and drink hot chocolate.
- Allyson JonesA good idea will keep you awake during the morning, but a great idea will keep
you awake during the night.
-Marilyn Vos SavantOne ought, everyday, to hear a song, read a fine poem, and, if possible, to speak a
few reasonable words.
-GoetheWisdom is what makes a poor man a king, a weak person powerful, a good
generation of a bad one, a foolish man reasonable.
-Irish sayingThere is this difference between happiness and wisdom: he that thinks himself the
happiest man, really is so; but he that thinks himself the wisest, is generally the
greatest fool.
-Charles Caleb Colton******************************************************************
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EXERCISE 5
This is a free-form writing exercise. Choose a special trip you would like to write
about. Read the questions and answer each in a paragraph. You can start with a
new document. When you have finished you can look it over to see if there is
anything else you want to add or change.

A WONDERFUL VACATION

Where did you go, when and for how long?

Did you travel on your own or with family or friends?

How did you get there?

What was special about this holiday? Sights you saw, people you met?

******************************************************************
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EXERCISE 6
For this exercise choose who you would like to write about and start a new
document, giving it an appropriate title. Read the questions and answer each in a
paragraph. Then you may want to expand it with additional paragraphs.

A SPECIAL
SON/DAUGHTER/NEPHEW/NIECE/GRANDDAUGHTER/GRANDSON

Who is this special person – name, age?

Where does she/he live? Have you seen him/her recently? Are there things you
like to do together?

What are his/her activities – studies/work/family responsibilities?

What does he/she look like? Is there a family resemblance?

What would you wish him/her for the future?

******************************************************************
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EXERCISE 7
There are quite a few mistakes (typos) in this article. Practice your editing skills
by making the corrections, and learn about the Internet at the same time.

INTERNET AND THE WORLD WIDE WEB
WHAT IS THE INTERNET?
The Internet, the Net, the Information Highway etc., is a giant network, which
connects computers around the world. It is a global system connecting publik and
private computer networks. It enables universities, governments, business and
consumers to share files, post notices annd converse via computers, modems and
phone lines.
HOW DO ALL THOSE COMPUTTERS TALK TO EACH OTHER?
The Internet uses a set of standards called TCP/IP. They let different types of
machines on different types of networks share information. The information is
transmitted through a process called PACKET SWITCHING. Now, yyou could
move a file from Computer A to Computer B by stringing a permanent phone line
between the two. But that would be impractial and expensive. With packetswitching technology, the file is broken up into small packets, which are
individually addressed and routed from stop to stop along the network before being
re-assembled at their final destination. It’s like mailing a pack of playing cards
from Tadoussac to Nanaimo - in 52 envelopes.
WHERE DID IT COME FROM
The Internet began as an experimental system, funded by the U.S. Department of
Defense’s Advanced Research Project Agency. In the network’s earliest days, only
computer scientists at a handful of research institutions across the country were
given access. As the Net grew, its population broadened to include researchers
from other dissiplines. Only in recent years did businesses, government aand large
numbers of people without technical or academic backgrounds, begin to homestead
on the Net.
HAT IS THE WORLD WIDE WEB?
The Web is an area of the Internet organized into “home pages” or “sites” – places
where you can get information about individuals, organizations, and almost evry
topic under the sun. The World Wide Webb contains text sound, video, graphics
and animation.
******************************************************************
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